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:_EndNcte20 for Win
Welcome to EndNote 2025

Thank you for choosing EndMote 20251 Discover new, intelligent
wisys 10 power your research. Endiote 2026 includes the
following new improvements and enhancemeants.

* Koy Takeaway

*Find & Journal

* Cite from a FDF

* Surnmary Panel Redesign

~weh of Science Citing Articles and Related Records
*Find Reference Updates and Find Full Text Improvements
* Sync Process Visibility
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& v = Option to Use En Dashes for Pages and Date Ranges
* Library Dietails in Libran Status \Wincow

- *Updates to the Edit Tab
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Read Me Information

_ _ EndNote 2025 for Windows Read Me ~
EndNote 2025 Volume License Version \ersion

April 2025
This copy of Endlote 2025 is licensed to.

CONTENTS:

Licensee: Diehu Gollege of Mursing

I NEW FEATURES
Il INSTALLATIONS
lll. CONTACT INFORMATION

Serial Number: 3032275758

By clicking the "Accept” button, | have obtained permission to
use this copy of EndNate 2025, and | have accepted the valume
license agreement for Deh Yu Caollege of Nursing, issued by
Clarivate Analytics

I. NEW FEATURES

Click "Cancel" bution to quitthis installation if you have not Key Takeaway

obtained permission to use. or you do notwant o accept the

license agreement for this software Find a Journal

* Cite from a PDF ~

Sance Dok Cancsl

< Back

8 : HfERd IR ERFL AAMH (RS By A&
B TTHEEISE Accept(f%

3 EndNote 2025 Setup — >4
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License Agreement

EndMote® End User License Agreement -~

THE TERMS AND COMNDITIONS OF THIS AGREEMEMNT
SHALL NOT APPLY IF YOU HAVE OBTAINED ACCESS TO
THIS PRODUCT PURSUANT TO AN INSTITUTIOMNAL SITE
LICENSE. UNDER SUCH CIRCUMSTAMNCES, YOUR USE OF
THIS PRODUCT SHALL BE GOVERNED SOLELY BY THE
TERMS AND CONDITIONS OF SUCH LICENSE. f you would
like to understand more about all of the rights that you or your
employer have to use the Product, you should refer to the
institutional site license agreemeant between you or your
employer and Clarivate or autharized resellers

BACKGROUND. Camelot UK Bidco Limited ("Clarivate
Analytics") has developed a proprietary software application
known as EndMNote® (the "Software"). By using the Software

and/or its accompanying manuals (the "Documentation” and
|together with the Software, the "Product”). you (the "End User”)

acceptthe license agreement I
| do not accept the license agreement

10 : BEZIRERLEIR B A% Next
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EndNote
2025

Select Installation Type

(O Typical

All application features and the Most Popular Bibliographic
Output Styles. Online Connections. and Import Filters will be
installed. This option is tecommended for the best
perfarmance.

@) Custom
Use this option to choose specific application features and
any Bibliographic Output Stles, Online Connections. and
Import Filters you want to install in addition to the Most
Popularfiles. This is recommended for advanced EndMNote
users

Cancel

3 EndNote 2025 Setup - X

Select Destination

EndNote
2025

The ‘Wise Installation Wizard will install the files for EndMate
2025 in the following folder.

Toinstall into a different folder. click the Browse buttan, and
select another folder.

'ou can choose notto install Endiote 2025 by clicking
Cancel to exitthe Wise Installation Wizard

Destination Folder

Ch\Program Files (x86)\EndMate 20254 Browse
< Back MNext > Cancel

11 BEE e 3eHYE H B A (Typical) 5052 8 (Custom)

i3 EndNote 2025 Setup

EndNote
2025

Digk Cost

Select Features

=3 ~| EndMote Application
- =2 » | Cite While ¥ou ‘White far Microsoft Office
- &3 = | Extension for OpenOffice and LibreOffice

=3 ~| EndMote Click Browser Reference Capture
_X -| Additional Connectinns

_X ~| Additional Filters

% ~| Additional Styles

=3~ Speling Dictionaries

Install Direct Expont Helper

FReset Cancel

12 : TR IR () B Next

15 EndNote 2025 Setup - X

Select Features

EndNote
2025

= Will be installed on local hard drive.
=i Entire feature will be installed on local hard drive.

& Feature will be installed when required.

X | Additional Filers

X ~| Additional Styles
=3~ Spelling Dictionaries

Cancel

Disk Cost Beset

13 © HIRZAETHH
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EndNote
2025

Disk Cost

Select Features

= |=3-| Endrote for Windows
&~ EndMote Application
=3 - Cite While You \Whrite for Microsoft Office
Extension for OpenOffice and LibreOffice
EndMote Click Browser Reference Capture
Monel Connecions
_=3~| Additional Filters
=3~ | Additional Styles

. &3~ | Speling Dictionaries

<

I [Jinstall Direct Export Helper I

<Back et >

Resst Cancel

14 : #E}¥ Entire feature will be installed on local drive

3 EndNote 2025 Setup

EndNote
2025

EndNote 2025 has been successfully
installed.

Click the Finish buttan to exit this installation.

15 : B PFi4)#E Install Direct Expert Helper

16 * ZEFIEE R AT H] (finish)
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eve L) EndNote 2025 Installer

EndNote 2025

Multi-user and site license
unlocked installer

376973735.dmg
119 MB el e 222

Tinstall EndNote 2025,
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el EndNote 20!
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EndNote 2025 Customizer EndNote 2026 Customizer
Welcome to EndNote 2025 Read Me
- Welcome . Wel
L Thank you for choosing EndNote 2025! Discover new, intelligent ways Some 52‘{’::{:322”5 for mecOS Read Me
* Read Me to power your research. EndNote 2025 includes the following new - Read Me a0
. Updating System improvements and enhancements: + Updating System
- Summary * Key Takeaway ERSny CONTENTS:
* Find a Journal >
* Cite from a PDF
* Summary Panel Redesign
* Web of Science Citing Articles and Related Records H I':fsv{:i’;‘;lfgﬁg
* Find Reference Updates and Find Full Text Improvements N CONTACTINFORMATION
* Sync Process Visibility g
* Option to Use En Dashes for Pages and Date Ranges
* Library Details in Library Status Window
* Updates to the Edit Tab LW
* Key Takeaway
* Find a Journal
* Cite from a PDF
Cancel [ Next ] Cancel

L7958 Next

Thank you for using EndNote 2025
+ Welcome
- Read Me
- Updating System
+ Summary

Thank you for using EndNote 2026!

Done
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EndNote 2025 File Edit Refere

About EndNote 2025.1

Settings...
Customizer...
Check for Updates...

Activate EndNote

Services

Hide EndNote 2025.1
Hide Others
Show All

Quit EndNote 2025.1 ¥Q

B 21: EAE

B2 E (Customizer)

EndNote 2025.1 Customizer

Select Components

c Install  Description
+ Updating System Cite While You Write Cite While You Write addin for Micro
+ Summary Services Services for Mac OS X
Spotlight V] Spotlight Indexing
> Connections Additional Connection Files
> Import Filters Additional Import Filters
> Output Styles v Additional Bibliographical Output Sty
?  Cancel Uninstall [ Next ]
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Save As: | My EndNote Library
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Where: [ Desktop v

Save as Package

The EndNote Library Package is a single document that
contains both the library and the data folder.
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File Edit Ref es Groups Tags Library Tools Window Help

Library Status Library Status
All Referenc

Sync Configuration
Unfiled Synchronize your data with your EndNote account to keep you
Trash

MY GROUPS
v My Groups
MY TAGS +
FIND FULL TEXT

GROUPS SHARED BY O...
ONLINE SEARCH +

You already have a synced library. If you choose to sync this lib

{ E @

Synced library location: C:\Users\user\Desktop\1141119.enl

Library Details

< € <<

Location: C:\Users\user\Desktop\111.enl

@ Jisc Library Hub Discover

Ref 0
@ Library of Congress EIRIEHEES i
J * in library: 0
@ PubMed (NLM) In trash: O

24 © FEHIRIRALE
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dit References Groups Library Tools Window Help

Set up EndNote Library

If you already have an EndNate library, pleasa locate it and we'll get it set up.
Open an existing library

Alternatively, you can start from scratch with a new library.

Create a new library

(= ) EndNote & &
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EndNote ¥
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Hle Edit References Groups lags Library lools Window Help

< Library Status All References +

£ Al References ‘
£ Recently Added
&l Unfiled

W Trash

Advanced search

SRz AE L B TEHERY P BT FERT

£ No reference selected

v MY GROUPS
v My Groups
' MY TAGS

All References

@

0 References

[ | Reference Type | Author [

V' FIND FULL TEXT

' GROUPS SHARED BY O...
\/ ONLINE SEARCH L

@ Jisc Library Hub Discover

Congress
@ PubMed (NLM)
® Web of Science Core C...

TOHREREG

Search for group = )
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New...

Open Library.. Ctrl+0
Open Shared Library... Ctrtl+Shift+O
Open Recent »

Close Library Ctrl+W

Save Ctrl+s
Save As..

Save a Copy..

Share...

Syport..

mport »
Print... Ctrl+P
Print Preview

Drint Setup..

Compress Library (.enlx) ...

Exit Ctrl+Q

"File —
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(2) All References : »3%% ¢

(3) Recently Added @ #ig% » (& 52 24/} FF~T=X ~14 = ~30 %)
(4) Unfiled: A~ ag3 p

(5) Trash : Fi% 2P

(6) My Groups : ¥ p 37 &

(7) My Tags : ¥ p 374t > &3z Reference

(8) Find Full Text: &35 >~ (22 ¥_% % %_Open URL 4p )

(9) Group shared by others: 22 % & % &% g%%iﬂ

(10)0nline Search : ¥ # &AM FHE(EF 2 5 1)

TR EAART (eR 28)

4+ =¥ &% Simple search(f§ % # % )# Advanced search(i&Ff# %)%
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p
D

/\\

(2) 7 F BBLE eI F R A
(3) BEZ Pt T PP FEIMAT > THET 2 Sl T
Aifarrece e
|
@FE*@ I Advanced search
i
Reference Type Author Year  Title Rating
2L S5 AR A3 7T HE 5

28 1 HHIEHAHE

A Sl

(1) B2 g™ B RHERFEE SBART ™ > RN (e D APA Tth) » 7R
51% 38 (e @l 29)

(2) 2 %iB(Edit) > ¥ %hiE:% 3 p £ 407 % 4% 5 5 THAttach file, ¥ #73
bk o BLEPDF RIT AT e @2 2% (4o 30-8 3D

(3) B (Insert) > BIF E 451 % A% 2 p 3 ¥ 5 2 & (4oH 32)
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+ Attach file

1 W) R 4 ) TR AR T A T R B A A 22 FE

2021 #4  Summary Edit PDF X

3% 2021 Vol. 68 Issuc 5 Pages 18-23

DO 10.6224/jn.207110_68(5).04

EFIEIR (virtual reality ) EFIAEREE—E _ ==
R SRR IRHEAERE - BE - RS
HENRR  GEREREHHSE
ZERARRA - TI#R5E R AE SR AR AR L T
BEFA ( virlual patient )
HARPERREREEFEL
BEEAN ) LR ST
RIS ER ST R — R

FTEmAl! 35 . HdE LTS R R
= - IR AREER - ABRRRER - BAZER

APA /th ~ ‘l‘ Insert ‘ ‘ Copy ‘ ~

TIE. (P021). EREL EnE SIS B R AR MR
“ZPE[T] [Applying Virtual Reality Assisted
Critical Thinking Training Programs Among
Nurse Practitioners]. Z7Z#£55, 00(5). 18-23.
https://doi.org/10.6224/jn.202110 68(5).04
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B .., 2023 #1 Summary Edit PDF [ £~ X

FRAENTERRRIRIEERD

HEE BNE

Issue 2 Pages 78-83

File Attachments

+ Attach file

Tags

Manage tags
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(Reference Type) (¥r@ 34)

¥ % enter 441 T - 7 (4ol 34) 0 B it
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73 ~

B BR.,2021#7  summay| Edit |PDF X
B/ UXX Q Save
Reference Type _JoumaIArticle v
Author BEBE
BER
IRIEME
Year 2021

Title  EHBERNSEFEMEEA
BEAERLSEREZAY
Journal B
Volume 68

Part/Supplement

Issue

«

Pages 51-64
Start Page

Errata

30 : f71E

g .. 2023 #1 Summary Edit POF [ £+ X

FrAEDRERBEIRIEER
HAE & B
I

2023

Issue 2 Pages 78-83

File Attachments
| D SatEaReamEsod -

+ Attach file
Tags

‘ Manage tags

[ APA 7th v

[ Cimert ) [Ceom ]

EEE & BNF. (023). TRAEBBHRERFIORBEREA.
EEHET 70(2), 78-83.
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File Edit ences Groups Tags Library Tools Window Help

New Reference Ctr+N B Edit PDF Edit&PDF
Edit Reference Ctrl+E B I UXXnamv Q (Tools ~
Copy References To ’ &

Tags l Manage tags

Copy Formatted Reference ~ Ctrl+K

E-mal Reference | Reference Type | Journal Atice ;
Move References to Trash (trl+D Author
File Attachments ) ; ‘2023—
ear
Find Full Text ) e — ;
Tile | @ emERRER RS ‘
Find Reference Updates : :
R ; Journal | WiEEEE ‘
Figure ) volume ‘70—‘
Part/Supplement ‘ ‘
Web of Science ' e —— !
Issue ‘2 ‘
Reference Summary ———
Pages ‘78—83 ‘

[E 33 : BiTHEEH @ 34 : BEESURIER(Reference Type) 1% A& H BRI (T & (Save)

g .., 2023 #1 Summary PDF &£
B 1 UX XA A [ook ] |m|

Tags [ Manage tags

Reference Type ‘qumal Article 2 ‘

b3

Author
B

za3

Year [ 2023 ]

EndNote

Tte | SAEBREETOREER

Do you want to save the changes you made to the reference?

Journal

EERE

nu

Velurfie ‘ 70 ‘ Your changes will be lost if you don't save them.

Part/Supplement

"D not display this message again.

Issue ‘ 2 ‘

Pages ‘ 78-83 ‘
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fd s A~ 91% s fis - Export ~ Cite ~ Citation manager ~ Ris format------
* % m&"l’]ﬁ% it L X enw~ X ris ~ X ciw ~ X, nbib------
(-HEER BT &
1‘E%%B?%%m
(1) AP sl BEL T REed gl ToU Al B

" (*ﬁf@ 37)
(2) ## "= 4% Endnote ; (4-@ 38)
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